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[bookmark: _GoBack]The following experiments are going to be performed with this experiment kit:

Experiment 4.1: Beer-Lambert law 

Experiment 4.2: Emission spectrum of light sources 





Spectroscopy Concepts

Overview

Scientific discoveries are based on observations. Scientists look for patterns in what they see, hear, feel, smell and taste to formulate theories and make predictions. Originally, scientists depended solely on their own senses to make observations. But as science has evolved, scientists have developed instruments to extend their observational powers beyond our sensory limits. Telescopes have enabled astronomers to see more of the sky and vastly improve our understanding of the heavens. Likewise, microscopes have enabled biologists to view ever-smaller parts of living organisms in their quest to understand living systems.

Astronomers are only limited by the size of the telescopes they can build and the distorting effects of the earth's atmosphere. As technological developments have allowed for bigger mirrors and space-based platforms, astronomers have been able to see ever further into space and make more and more discoveries. Unfortunately, the situation is very different going in the other direction. There is a physical limit to the size of objects that can be "seen". This limit is due to the nature of light itself.

Light

Light is also known as electromagnetic radiation. Light consists of photons, little packets of energy that have properties of both particles and waves. All waves have a wavelength, the length of one complete cycle of the vibration. For light, the range of possible wavelengths is enormous. Figure 4.1 gives the range of known wavelengths of electromagnetic radiation and the common names given to radiation of particular wavelengths.

It is the wave properties that limit our ability to use light to create images. For any given wavelength, that light can only be used to form images of things that are larger than that wavelength. For visible light, with wavelengths between 4 x 10-7 and 7 x 10-7 m, it is impossible to form images of atoms which have sizes on the order of 10-9 m. Very large molecular assemblies such as chromosomes (DNA molecules coated with protein molecules) are the smallest things we can "see" by forming an image.

The problem faced by chemists, biochemists and microbiologists is to gain an understanding of what happens at the atomic and molecular level without actually being able to "see" atoms and molecules. Even though we can't make images of atoms and molecules, we can use light to learn about the structures of atoms and molecules. This is because atoms and molecules can absorb or emit light. By looking at the light that is absorbed or emitted we can learn about the species involved. The technique for looking at such light is referred to as spectroscopy. It is the only tool available to astronomers to collect information about the cosmos. It is the most powerful tool available to scientists to study atoms and molecules, a technique that is universally used in science and engineering disciplines.
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Figure 4.1 Wavelength ranges

Wavelength and Energy
Our understanding of the nature of light is a rather recent development. For a long time the different forms of electromagnetic radiation were thought to be different phenomena. Thus, we have the collection of common names ending in -wave and –ray for the various wavelength ranges. This is because the energy of a photon is related (inversely) to its wavelength.

Where: 
E = energy of the photon in joules,
 = wavelength in nanometers, 
h = Plank's constant , 
c = speed of light.
Remember that, he shorter the wavelength, the higher the energy of the photon.
Because the wavelength range of known electromagnetic radiation is enormous, the difference in energy of photons is also enormous. And it is this energy that will determine the effect of the photon when it interacts with matter. The radio frequency photons have very small energies, which is why we can saturate our atmosphere with them without affecting our environment. The amount of energy they impart to the atoms that absorb them is almost negligible. Infrared photons have enough energy to heat objects and, as a result, they make great heat lamps. Ultraviolet photons have enough energy to break chemical bonds and can cause molecular rearrangements resulting in effects like sunburn and genetic damage. X-rays are very energetic and readily break even the strongest bonds causing significant molecular destruction. For this reason the medical use of X-rays is destructive of living tissues and must be done carefully and only in extremely small doses.

The Interaction of Light with Matter
To be more correct, it is usually the electrons in atoms and molecules that absorb and emit photons of light (Gamma rays are energetic enough to interact with atomic nuclei, but we'll leave that topic to the physicists to pursue). An electron can absorb low energy photons, like radio frequencies, by flipping its "spin". This effect is used to create nuclear magnetic resonance spectroscopy (NMR) and magnetic resonance imaging (MRI). An electron can absorb infrared, visible and ultra violet photons by changing its energy level. All electrons have a series of energy levels they can occupy. The lowest energy level is referred to as the "ground state". The highest level is the "ionization energy", the energy required to completely remove the electron from the influence of the nucleus. In order for an electron to move from one level to a higher level it must absorb energy equal to the difference in the levels. Likewise, to move to a lower level the electron must give up energy equal to the difference. Because there are a limited number of levels the electron can occupy, there are limited amounts of energy it can absorb or give up.
A more detailed discussion can be found in Chemistry and Chemical Reactivity, Chapter 7 by Kotz and Treichel. Figure 4.2 is a diagram of the most common transitions possible for a sodium atom. The 3s to 4p transition is in the ultraviolet range. The 3p to 3d transition is in the infrared range. And the 3s to 3p transition is in the orange region of the visible spectrum. This line is the source of the characteristic color of sodium vapor lamps.
There are a number of ways an electron can gain or lose energy. The one of interest here is the absorption or emission of light. An electron can absorb a photon of light that strikes it only if that photon has the exact energy to change the electron to a higher allowed energy level. An electron already at a higher level can emit a photon of light having exactly enough energy to change that electron to one of its lower allowed levels. Notice that an electron in the ground state cannot emit any photons as it already has the least possible energy.



[image: ]
Figure 4.2: A diagram of the most common transitions possible for a sodium atom. 
The magnitude of the difference in allowed energy levels determines which kinds of light can be used to study particular atoms and molecules. While spectroscopy is conducted in nearly all regions of the electromagnetic spectrum, practical considerations make the infrared, visible and ultraviolet regions the most useful in chemical laboratories. Infrared spectroscopy is particularly useful for studying the bonds between carbon, hydrogen, oxygen and nitrogen atoms that predominate in organic compounds. Thus, infrared is a key tool of the organic chemist. Infrared spectra can indicate the presence of particular structures in unknown organic compounds by the presence of characteristic features. They can also be used to confirm the identity of compounds by comparison with known spectra. Reference books containing thousands of spectra of known organic compounds are available for this purpose.
Visible light spectroscopy is particularly useful for studying certain kinds of organic compounds and elements that have electrons in d-orbitals, such as transition metals. Ultraviolet spectroscopy is useful for studying certain kinds of organic compounds that predominate in biological contexts. All proteins have useful ultraviolet spectra as do DNA and many reaction co-factors. Many biochemical reactions can be effectively monitored in the ultraviolet and this tool is commonly found in biochemical laboratories. In clinical laboratories, ultraviolet spectroscopy is often the means for making quantitative determinations on plasma and urine samples.

Types of Spectroscopy
Spectroscopy is the study of the interactions of light with matter. There are two distinct aspects of this interaction that can be used to learn about atoms and molecules. One is the identification of the wavelengths of light that interact with atoms and molecules. The other is the measurement of the amount of light being absorbed or emitted at any particular wavelength. Both determinations require separating a light source into its component wavelengths. Thus, a critical component of any spectroscopic measurement is the breaking up of light into a spectrum. For each of these aspects there are two ways observations can be made: the light that is absorbed by atoms and molecules, and the light that is emitted. This creates a total of four different kinds of spectroscopy: absorption, emission, qualitative and quantitative.
Absorption Spectroscopy
Absorption spectroscopy is the study of light absorbed by molecules. In it, white light is caused to pass through a sample and then through a device (such as a prism) that breaks the light up into a spectrum. You will recall that white light is a mixture of all wavelengths of visible light. When such light is passed through a sample, under the right conditions, the electrons of the sample will absorb those wavelengths of light that can change them to other levels. Thus, the light coming out of the prism will be missing those wavelengths corresponding to the allowed energy levels of the electrons in the sample. We will see a spectrum with black lines where the absorbed light would have been if it had not been removed by the sample.
Emission Spectroscopy
Emission spectroscopy is the opposite of absorption spectroscopy. The electrons of the sample are promoted to very high energy levels by any one of a variety of methods (e.g., electric discharge, heat, laser light, etc.). As these electrons return to lower levels they emit light. By collecting this light and passing it through a prism, it is separated into a spectrum. This time, however, we will see only a dark field with colored lines that correspond to the electron transitions. Figure 4.3 shows the view through the telescope of the 589 nm Helium emission line with a scale superimposed. Notice that the absorption and emission spectra of the same substance will have the same values for wavelength. In the absorption spectrum these values will appear as black lines on a colored field whereas in the emission spectrum they will be colored lines on a black field.
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Figure 4.3: Creating a flame emission
Qualitative Spectroscopy
One of the useful aspects of spectroscopy derives from the fact that the spectrum of a chemical species is unique to that species. Identical atoms and molecules will always have the same spectra. Different species will have different spectra. Thus, the spectrum of a species can be thought of as a fingerprint for that species. Qualitative spectroscopy is used to identify chemical species by making a spectrum and comparing it with known spectra to find a match.
As an example, consider the discovery of the element Helium. It was first observed, not on the earth, but in the sun! In 1868 the French astronomer, Pierre-Jules-Cesar Janssen, was in India to observe a solar eclipse when he detected new lines in the solar spectrum. No element known at that time would produce these lines and so he concluded that the sun contained a new element. This initiated a search for the new element on planet earth. By the end of that century, the new element had been identified in uranium ores and was named Helium after the Greek word for the sun (Helios). Today, spectroscopy finds wide application in the identification of chemical species.
Quantitative Spectroscopy
Quantitative spectroscopy is one of the quick and easiest ways to determine how many atoms or molecules are present in a sample. This is because the interaction of light with matter is a stoichiometric interaction. At any given temperature, the same number of photons will always be absorbed or emitted by the same number of atoms or molecules in a given period of time. This makes spectroscopy one of the few techniques that can provide a direct measure of the number of atoms or molecules present in a sample.
Quantitative emission spectroscopy requires samples be heated very hot to enable electrons to emit light. Most often, this is done by feeding the sample into a burner flame. As a result, it is not practical for use with most molecular compounds. It is frequently employed for elemental analysis. A quantitative emission technique, flame photometry, is employed in clinical labs to determine sodium and potassium levels in blood plasma and urine.
Because quantitative absorption spectroscopy can be done at room temperature, it is the more common technique. It is usually performed on samples dissolved in solution. In clinical labs, determinations of the amounts of compounds like glucose and cholesterol in blood and urine samples employ this technique.
Absorption spectroscopy is performed by passing light of all wavelengths through a sample and measuring how much of each wavelength is absorbed. The statement made above that "the absorption spectrum will appear as black lines on a colored field" is a considerable oversimplification. The complex interactions of atoms and molecules with water molecules in solution make the absorbance of light in solutions a very complex phenomenon. Nevertheless, the patterns are repeatable and predictable, thus making them useful. By making absorbance measurements at various wavelengths and then plotting the result, one can create what is known as an absorbance trace.  Figure 4.4 is an example of such a trace. Absorbance traces are like fingerprints. Each compound has its own unique trace. In some cases this can be used to identify the presence of certain compounds in a sample. More often, it is used to determine the amount of compound present.
[image: ]
Figure 4.4: Absorbance spectrum of hemoglobin in the visible region 

Color and Wavelength
[image: ]
The visible region is a good place to begin an investigation of spectroscopy because it is a critical feature of our everyday world. This phenomenon is known as color vision. Our perception of color is the eye's response to light of different wavelengths. When photons of a narrow wavelength range interact with our retina, we perceive the effect as color. Thus, the apparent color of an object is due to the wavelengths of the photons of light reaching our eyes from that object. This is true whether the object is emitting its own light or reflecting light from another source. In a sense, our eyes operate like spectrophotometers.
White light is an equal mixture of light of all wavelengths (colors). When such light strikes an object and is completely reflected, we see equal amounts of light of all colors and perceive the object to be white. When all light striking an object is absorbed, no light enters our eyes and we perceive the object to be black. A sheet of paper is white because all light striking it is reflected and none is absorbed. The print on the paper is black because all light striking it is absorbed. None is reflected. We perceive color when some wavelengths of light are reflected (or transmitted, as in the case of a solution) more than others.
There is a rather complex pattern to the absorption of light by colored objects. The statement that "an object appears red because all red light is reflected and all other light is absorbed" is a considerable oversimplification. In fact, varying amounts of light of different wavelengths are absorbed in most colored objects and the color we perceive is more closely related to the color that is most absorbed rather than to the color that is reflected.
The brain assigns color to an object by a process known as complementary color vision. According to this theory, all colors of light have a complementary color. This is often displayed through the use of a "color wheel" like the one shown in Figure 4.5. A color and its complementary color are opposite each other on the color wheel. The perception of color occurs when the optic nerve and the brain compare the amount of light of a particular color with the amount of its complementary color. If the two amounts are the same, we see gray or white. If not, we see color. Thus, a fire extinguisher appears red in white light because more blue-green light (the complementary color of red) is being absorbed than any other color. Of course, this also means that more red light is being reflected than its complementary color, blue-green. For all other colors, relatively equal amounts of each color, and its complement, are being reflected.


[image: ]
Figure 4.5: Color whell

Instruments that Generate Spectra

There is a large variety of instruments used to perform spectroscopy. They differ greatly in the kinds of information they provide. What they all have in common is the ability to break light up into its component wavelengths.

Spectroscopes
A spectroscope is simplest of spectroscopic instruments. Its function is to take light from any source and spread it into a spectrum for viewing with the unaided eye. Figure 4.6 is a diagram of a simple spectroscope. The light from the source passes through the slit and into the prism where it is spread into a spectrum. The telescope is used to focus on the light coming out of the prism. The third arm contains a wavelength scale that can be superimposed over the spectrum by shining a white light into it. Figure 4.7 shows a view through a spectroscope's telescope. Spectroscopes are useful for determining what wavelengths of light are present in a light source, but they are not very useful for determining the relative amounts of light at different wavelengths. Spectroscopes are most commonly used for qualitative emission spectroscopy.
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Figure 4.6: Diagram of a spectroscope
[image: ]
Figure 4.7: A view through a spectroscope's telescope      
                             
Spectrometers
A spectrometer is a spectroscope that has some sort of meter attached that can measure the amount of light (number of photons) at specific wavelengths. Thus, it is designed to provide a numerical measure of the amount of light emitted or absorbed at a particular wavelength. Figure 4.8 is a schematic of a spectrometer. It is constructed so that the wavelength can be varied by the operator and the amount of radiation absorbed or transmitted by the sample determined for each wavelength. In this way it is possible to learn which wavelengths of radiation are present and in what relative amounts. Spectrometers are common in astronomy where they are used to evaluate the light collected by telescopes. They are the only source of information we have about the chemical composition of the universe outside our own solar system.
 [image: ]
Şekil 4.8 Schematic representation of a spectrometer
Light enters the spectrometer via the entrance slit and then passes through several parts: an objective lens, a grating, and an exit slit. This combination of parts functions as a monochromator, a device which selects only one color (actually, a narrow band of wavelengths) from all of the wavelengths/colors present in the source. A particular wavelength is selected, using the wavelength control, by adjusting the angle of the grating. This works because different wavelengths of light reflect off the grating at different angles. The net result is the separation of white light into a "rainbow" much like light transmitted through a prism of glass. The selected wavelength is at the center of the narrow band of wavelengths passing through the slit.
The light then strikes a detector that generates a voltage in proportion to the intensity of the light hitting it. That voltage is then used to drive a read-out device that is designed to provide data in a useful fashion such as intensity.
As with all electronic devices, the design and operation of spectrometers had been greatly impacted by the developments of the latter half of the 20th century. Perhaps the most crucial was the development in the early 70's of the Charged Coupled Device (CCD). Originally conceived as a new mode of data storage, it was soon discovered that CCDs held great promise as imaging devices. An imaging device is something that electronically mimics what photographic film does. Charged Couple Devices consist of a number of elements between which charge can be shifted. In an image sensor, light falling on the array of elements produces a pattern of charges corresponding to the image. This image can then be electronically transported to some other location, such as a monitor, and reconstructed. CCDs were first employed to replace photographic plates in telescopes. The first such device was installed on the I-meter telescope at Kitt Peak National Observatory in 1979. Today, CCDs are the detectors that make digital cameras not only possible, but affordable.
Soon after its successful application to astronomical problems, it was determined that CCDs could greatly enhance the performance of spectrometers. This was achieved by replacing both the exit slit and detector with a CCD array. Now, it was no longer necessary to measure light intensity one wavelength at a time. The number of wavelengths, that can be monitored simultaneously is determined by the number of elements in the CCD array. Figure 4.9 is a schematic of a spectrometer outfitted with a CCD array. The array generates an output that can be used to reconstruct the intensity of light striking each of the elements in the array. This output can be sent to a monitor or a printer for display. The output is instantaneous across the spectrum. No longer is it necessary to "scan" back and forth across the spectrum to identify light intensity at individual wavelengths.
 [image: ] 
Figure 4.9: A schematic of a spectrometer outfitted with a CCD array

Spectrophotometers
Since spectrometers measure the amount of light entering the instrument, they are most often used for emission spectroscopy. In order to perform absorption spectroscopy, a light source of known intensity is required. An instrument that includes such a light source is known as a spectrophotometer. It is constructed so that the sample to be studied can be irradiated with light of known wavelength and intensity. The wavelength can be varied and the amount of radiation absorbed or transmitted by the sample determined for each wavelength. From this information, an absorption spectrum for a species can be obtained and used for both qualitative and quantitative determinations.
Spectrophotometers measure the amount of light transmitted by a sample and then convert this to more useful measures. One is the ratio of the transmitted light (I) to the incident light (Io), expressed as a percent. This is known as the percent transmittance (% T).



The %T calculation is easy to design into a spectrophotometer and was a common output before the advent of computer chips. A more useful quantity is the absorbance, A or Abs, because it is directly related to the molar concentration of the chemical species doing the absorbing. Absorbance values can be obtained from % T values using the following expression.
 [image: ]
There is an assumption inherent in the calculation of either %T or absorbance. The assumption is that, all light not transmitted to the detector is absorbed by the chemical compounds in the solution. Two other possibilities exist. One is that the light is being scattered by the solution. Samples containing solid material, or which are cloudy, are difficult to analyze using a spectrophotometer. Samples encountered in the commercial world (biological fluids, soil solutions, etc.) are often cloudy and extra steps must be employed before analysis by absorption spectrophotometry can begin.
The other assumption is that light might be scattered or absorbed by the container used to hold the solution. Care must be taken to ensure that the sample cells do not affect the measurement. The cells must be constructed of absolutely clear glass. If measurements are to be made below 350 nm, they must be made of quartz glass. Regular glasses are opaque below 350 nm.
The Beer-Lambert Law
The relationship between absorbance and concentration is known as the Beer-Lambert Law, or sometimes simply Beer's Law,

Where,
A = measured absorbance, c = concentration of the absorbing species, b = path length of the sample (width of the cuvette)  = a proportionality constant known as the molar absorptivity with units of (M-1cm-1).
The molar absorptivity is constant for a specific chemical compound and a specific wavelength. For most compounds there is typically at least one wavelength where  reaches a maximum. This wavelength is often chosen to carry out absorption spectrophotometry of that compound. For example, consider the visible spectrum of hemoglobin (Figure 4.4). There are three wavelengths in the visible range that would be suitable: 412, 541 and 576 nm.
If the molar absorptivity is known at a particular wavelength, the concentration of a chemical compound present in a transparent sample can be calculated from the measured absorbance using Beer's Law. The simplest way to determine  is to take a solution of known concentration, select the wavelength for which the value of  is desired (usually the wavelength where the absorbance has its greatest value), measure the absorbance there and measure the path length. The above equation can be rearranged to solve for  ( = A / bc) and the value computed from the experimental measurements. The result, however, may not be reliable. For example, the Spec 20, one of the spectrophotometers available for your use, produces reliable results only in the absorbance range of to 0.01 to 1.5. A value outside this range will have questionable meaning. It is also possible for the instrument to malfunction or to be operated improperly. Therefore, multiple measurements of a number of samples under a variety of conditions are required to provide a believable answer.
A more accurate method to determine  is to measure the absorbance of a number of solutions of different concentrations and construct a calibration plot. Beer's law is a linear equation of the form



[image: ]

(b, the y intercept, is zero and therefore does not appear in the Beer's law equation.) A plot of absorbance vs. concentration should produce a straight line with a slope equal to b. Figure 4.10 is a representation of such a plot. Because the intercept is zero, a concentration value of zero should produce a zero absorbance and the origin of the plot (0, 0) should be a point on the plot.

[image: ]
Şekil 4.10 Represantation of an absorption-concentration graph
Determining E requires determining the slope of the best-fit line through the data points. Consider the data graphed in Figure 4.10. By selecting two points on the line and reading their coordinates, the slope can be calculated. To avoid biasing the readings, the points selected for this determination should not be the same as any of the data points.


As long as the path length through the sample can be measured,  can be calculated from the slope. One way to measure the path length is with a ruler. A more rigorous method is to measure the absorbance of a standard solution having a known concentration and molar absorptivity and then calculate the path length from Beer's Law.
Note that the value of b may vary from cuvette to cuvette. It will also vary with the orientation of the cuvette in the sample holder if the cuvette does not have a uniform diameter in all directions. To maintain optimal accuracy, one should always use the same cuvette and make sure it is oriented the same way every time it is placed in the spectrophotometer.
It is possible to read the concentration of an unknown sample directly from a calibration plot by interpolation using the measured absorbance of the unknown sample. In the example shown in Figure 4.11, an absorbance reading of 0.45 produces a concentration of 2.7 x 10-5 M.
 
[image: ]
Figure 4.11: Interpolating Concentrations from a Beer’s Law Plot



[bookmark: _Toc357942387]EXPERIMENT 4.1: BEER-LAMBERT LAW 


The direct relationship between absorbance and concentration for a solution is known as the Beer- Lambert Law, or more commonly Beer’s law. You can use Beer’s law to test several samples of a solution, of known molar concentrations, and calculate a best-fit line equation to relate the absorbances of the solutions to their concentrations.

The primary objective of this experiment is to determine the concentration of an unknown cobalt (II) chloride, CoCl2, solution. You will first use a spectrometer to measure the absorbance of one CoCl2 solution over the visible light spectrum and select the wavelength of maximum absorbance. You will prepare five cobalt (II) chloride solutions of known concentration, which are your standard solutions. You will to measure the concentration of each standard solution to establish the Beer’s law best-fit line equation for the CoCl2 standards.
You will use the best-fit line function for the standard solutions to determine the molar concentration of a CoCl2 solution of unknown concentration.

Materials
[image: ]
Procedure: Using Ocean Optics SpectraSuite Software
1. Label five test tubes to use for your standard solutions. Prepare the CoCl2 standards according to the chart below. 

	Test tube
	CoCl2
	mL (0.1M CoCl2)
	mL (distilled water)

	1
	0.02 M
	2.0
	8.0

	2
	0.04 M
	4.0
	6.0

	3
	0.06 M
	6.0
	4.0

	4
	0.08 M
	8.0
	2.0

	5
	0.10 M
	10.0
	0.0



2. Obtain a small amount of CoCl2 solution of unknown concentration. Set it aside to test after you have measured the absorbances of the standard solutions. 
3. Fill a cuvette ~2⁄3 full with distilled water to serve as your blank. 
4. Use a USB cable to connect a spectrometer to your computer. Start the SpectraSuite software.
5. Calibrate the spectrometer.
a. On the toolbar, check the box next to “Strobe/Lamp Enable”. Allow the  spectrometer to warm up for at least five minutes before proceeding. 
b. Place the blank cuvette in the spectrometer. Open the File menu and choose New  → Absorbance Measurement. The “Set Acquisition Parameters wizard” will appear. This process has four steps. First, confirm that your spectrometer has been identified, and then click [image: ]. 
c. In step two of this process, make sure that the box next to “Strobe/Lamp Enable” is checked. Manually select a suitable integration time by using the arrow keys to increase or decrease the integration time, in milliseconds. Click  to proceed. 
d. To record the absorbance spectrum of the blank (100% transmittance), click the  Store Reference Spectrum icon, [image: ]. Click [image: ]to proceed. 
e. Remove the blank cuvette and place the dark cuvette in the spectrometer. To save  the dark reference (0% transmittance), click the Store Dark Spectrum icon, [image: ]. 
f. Pour out the distilled water from the blank cuvette, rinse, and fill it with the 0.02  M CoCl2 solution in test tube #1. Place the cuvette in the spectrometer. Click to complete the acquisition parameters wizard. 
g. A plot of absorbance vs. wavelength for your CoCl2 solution is displayed. 
6. Important: Examine the graph and select the peak wavelength that you wish to use for your Beer’s law experiment. 
7. Set up the Beer’s law experiment.
a. Open the File menu and choose New → New Concentration Measurement. Select “Active Processing:”, and then click [image: ]. 
b. The Concentration Measurement Setup wizard appears, and its default is the Beer-Lambert Law. Select “Calibrate from solutions of known concentration”. Click [image: ]. 
c. The Range Selection defaults to a single wavelength. Enter the peak wavelength that you identified in Step 6, and then click [image: ]. 
d. The next dialog box sets up the Beer’s law graph of your standard solutions. Type in the molar concentration of your first sample, 0.02. Click , and then click [image: ]. The absorbance of your first standard is saved and plotted on the small graph in the dialog box. 
e. Remove the cuvette and dispose of the solution as directed. Rinse and fill the cuvette with the CoCl2 standard solution in test tube #2. Place the cuvette in the spectrometer. Type in the molar concentration, click [image: ], and then click  . 
f. Repeat step e for the remaining standards. When you complete the final standard  solution (0.10 M), type in the compound name and unit of concentration (mol/L). A best-fit line is calculated for your standards. Make sure the regression order is set to 1. Note: To delete a data point, choose a row of data and click  . Click [image: ]to continue. 
8. To measure the absorbance of the CoCl2 solution of unknown concentration, rinse and fill the cuvette ~2⁄3 full with the unknown sample. Click Single Update and write down the concentration of your unknown. 
9. To close the SpectraSuite program, select File → Exit, and then click [image: ]. 



Data


	Test tube
	Concentration
(mol/L)
	Absorbance

	1
	
	

	2
	
	

	3
	
	

	4
	
	

	5
	
	

	Unknown
	
	



Questions
· At what wavelength did you measure the absorbance of the CoCl2 standard solutions? If you had used a wavelength 10 nm greater or smaller than your choice, how would it have affected your results? 
· Does the temperature of the solutions matter when conducting a Beer’s Law experiment? Explain why or why not. 
· A student prepares the CoCl2 standard solutions by accidentally adding one extra mL of distilled water to each test tube. Explain how this error will affect the determination of a CoCl2 solution of unknown concentration? 





[bookmark: _Toc357942388]EXPERIMENT 4.2: EMISSION SPECTRUM OF LIGHT SOURCES 


Introduction

A fascinating feature of spectroscopy is how one can make use of light to learn about atomic and molecular structure. Under certain conditions, an atom or molecule will absorb or emit light. By examining and measuring the light that is absorbed or emitted by a substance, certain physical properties are revealed.

The electrons of atoms and molecules exist in specific energy states. The energy emitted by the excitation of electrons is limited to differences between these states, thus specific energies of light are emitted. The color of a glowing LED, for example, is a result of the energy of the emitted light. The energy and wavelength of the light is described by the equation E = hc/λ, where λ is the wavelength, h is Planck's constant (6.63 × 10-34 J sec), and c is the speed of light (3.00 × 108 m/sec). If you are measuring the emission spectrum of a gas trapped in a discharge tube, only certain wavelengths of light are emitted by the gas and the “pattern” that is produced is unique for that substance.
In this experiment you will use the spectrometer outfitted with a fiber optic cable to measure the emissions spectra of various sources of light.


Materials

[image: ]
Procedure: Using Ocean Optics SpectraSuite Software

1. Use a USB cable to connect an Ocean Optics or Vernier spectrometer to your computer. Make sure that the light source/cuvette holder has been detached from the spectrometer. Connect a fiber optic cable to the threaded detector housing of the spectrometer. 
2. Start the SpectraSuite program. 
3. Turn on the light source. Aim the tip of the fiber optic cable at the light source. 
4. There are two methods of optimizing the graph of intensity vs. wavelength. Depending on the light source you are measuring, one method may be better. 
a. Set the distance between the light source and the tip of the fiber optic cable so that the peak intensity on the graph is ~3500 counts.
b. Adjust the Integration Time, which is located in the upper left hand portion of the SpectraSuite window. If the peak absorbance is off scale, reduce the integration time. If the peaks are too small, increase the integration time. 
5. When you are satisfied with your emission graph, click save, [image: ]. In the Save Spectrum dialog box, click the Browse button, [image: ]. Choose a location for the file, name it, and then click the Save button, [image: ]. Back on the Save Spectrum dialog box, click. Click [image: ]to continue. 
6. To view the emission spectrum graph: 
a. Click the Overlay Spectral Data icon, [image: ], on the right of the toolbar. 
b. Choose the file you saved in Step 5, and then click the Open icon, . 
c. In the Load Spectrum dialog box, choose your file (which will be coded as  “Processed”), and then click the Load icon, [image: ]. 
7. To analyze your emission spectrum graph: 
a. Click anywhere on the graph to activate the cursor. Note the green vertical line  marking a given wavelength on the graph; a box below the graph identifies the  wavelength. 
b. Click on the peak, or peaks, of the emission spectrum. A legend below right of  the graph displays the counts at a specified wavelength. Write down the peak or peaks, as well as other distinguishing characteristics of the graph, in your lab book. 
8. Repeat Steps 4-6 to plot and capture the emission spectrum of a second light source. By using the Overlay Spectral Data option, you can plot more than on emission spectrum on the same graph. If you wish to remove a set of graphed data, click the Delete Overlay  Spectra icon, [image: ]. Choose the plot you want deleted (all of the plots are color-coded) and click [image: ]. After you have deleted the desired plot or plots, click [image: ]. 
9. To export the graphed emission measurements to Microsoft Excel: 
a. Click the Copy Spectral Data to Clipboard icon, [image: ], on the toolbar.
b. Open Excel. 
c. In Excel, open the Edit menu and choose Office Clipboard... 
d. Click the spectral data file on the clipboard. 
10. To close the SpectraSuite program, select File → Exit, and then click [image: ].

Data Analysis
[image: ]
1. Examine your first graph of emission. Identify the peak or peaks. Describe the distinguishing characteristics of the graph.
2. Examine your second graph of emission. As before, identify the peak or peaks and describe the distinguishing characteristics of the graph.
3. Are there any features of either graph that stand out as being unusual or unexpected?
4. Below are two emission graphs. The graph on the left is the emission from standard fluorescent office lighting. The graph on the right is the emission from a mercury discharge tube. Using these graphs, make a case either for or against the presence of mercury in the office lighting. The X- and Y-axis ranges for the graphs are identical.
5. 
[image: ]
Figure 4.12 Emission spectrum of fluorescence office light and mercury lamp
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